
File Menu



Open...

Opens a file dialog. You can select any of the supported animation or picture formats. After loading, the 
new projects will be displayed in  The Project List.    
The file dialog supports multiple selections, that means that several files can be marked for loading.    



Close

Removes the currently selected Project from The Project List and frees all memory dedicated to the 
project. 
This item is functionally identical with Remove Project of the Project menu. 



Save As...

Opens the save window. The All Frames item of  The Save Window will be checked. 



Close All

Removes all currently loaded projects from The Project List. 



Exit

Terminates MainActor.      



Edit Menu



Copy to Clipboard

Copies the currently selected frame image into the clipboard. 
The quality of this operation is dependent on your video mode, high / true color displays give better 
results, especially under Windows. 



Select

Selecting one of the three sub menu items allows you to select all, or some of the frames in The Frame 
List.    

Select All 
Selects all frames available in the frame list. 

Select Range ... 
Allows you to select a range of frames, for example frame 10 to 50. 

Select Compression ... 
Allows you to select all frames with a specific compression. For example, if you loaded a FLI 
animation, you can select all frames which have a ClrBlack compression method. 



Deselect

Selecting one of the three sub menu items allows you to deselect all, or some of the frames in The Frame
List.    

Deselect All 
Deselects all frames available in the frame list. 

Deselect Range ... 
Allows you to deselect a range of frames, for example frame 10 to 50. 

Deselect Compression ... 
Allows you to deselect all frames with a specific compression. For example, if you loaded a FLI 
animation, you can deselect all frames which have a Dummy compression method. 



Invert

Inverts the selection status of all frames in The Frame List.    
All selected frames will be deselected and all deselected frames will be selected.          



Edit Rexx

Edits the selected Rexx script. 



Start Rexx

Executes the selected Rexx script. 



Show Rexx I/O

Opens the Rexx I/O window. It displays the output of the Rexx scripts. 
This window will automatically be opened when a Rexx script is started by MainActor. 



Preview Video...

Opens the Video Preview window. 



Capture Video ...

Opens the Video Capture Interface window. If you have a video capture card installed, you can capture 
video directly inside MainActor with this function. 



Project Menu



Project Info...

Opens a dialog window which displays information about the currently selected Project.      



Global Timecode...

Opens a window which allows you to change the global timecode of the currently selected Project.    
Some animation formats (for example FLI/FLC) only support one timecode for all of the frames of an 
animation, that means that all frames will stop playback for the same amount of time. These animations 
often have dummy frames inserted into the animation to allow for better timing.    
If your project does not have a global timecode or does support a timecode for each frame, this menu 
item will be disabled. If it does support a timecode for each frame, you can select the frames you want to 
change the timecode of and select the Local Timecodes menu item of the Frames menu. 



Cache Data

Caches all the data of the currently selected Project in RAM, which results in better access and playback 
times for the project.    
If the menu item is checked the data is cached in memory, if not the data will be loaded directly from disk 
(which is the default).    
Note, not all loader modules support caching, if a loader module does not support caching, the menu item
is disabled. This is the case for most of the picture loader modules.      



Play Project

Plays the currently selected project. 



Remove Project

Removes the currently selected Project from The Project List and frees all memory dedicated to the 
project. 
This item is functionally identical with Close of the File menu. 



Frames Menu



Save Frames

Opens the save window. The Selected Frames item of The Save Window will be checked. 



Local Timecodes...

Opens a window which allows you to change the local timecodes of the currently selected frames.    
This option is only enabled if the animation format of your current Project supports a timecode per frame 
or if the project is a picture (list). 



Show Frames

Shows the currently selected frame. 



Show Palette

Displays the palette of the current frame in The Palette Editor. 



Sort Frames

Selecting one of the sub menu items sorts all frames in  The Frame List according to the selected sort 
method. This menu is only available when the currently selected  Project is a picture list. 
Animations are mostly delta encoded and cannot be sorted, even when they are nonlinear, it would be too
difficult to keep track of the different color palettes etc.    

Sort Frames by Name (Normal) 
The frames are sorted, case insensitive, by their names. 

Sort Frames by Name (Inverse) 
The frames are sorted, case insensitive, by their names in the inverse order. 

Sort Frames by Size 
The frames are sorted by their size. The pictures with the smallest size are at the top of the frame

list, the pictures with the biggest size at the bottom. 



Remove Frames

Removes the currently selected frames in The Frames List. 
This menu item is only active when the current project is a picture list. You cannot remove frames from an
animation. 



Settings Menu



Timecode Settings

Selecting one of the three sub menu items allows you to change the time system in which the timecodes 
in The Frame List are displayed. 

/1000 Sec 
This timecode setting displays the timecode for every frame in milliseconds. 

HH:MM:SS:MS 
The timecodes will be displayed as time offsets of the frames relative to the beginning of the project in 
hours, minutes, seconds and milliseconds. The head of the timecode column will display the time of 
the whole project. 

HH:MM:SS.FF 
In contrast to the first two settings, this setting is based on a frames per second basis. The timecodes 
are, again, treated as offsets. First, MainActor will determine the global frames per second rate of the 
project. Then it will display the timecodes, based on this fps rate, in hours, minutes, seconds and the 
frame offset. The frame offset is between 0 (the first frame of the second) and the frames per second 
rate minus one (the last frame of the second). The head of the timecode column will display the time of
the whole project. 



Playback Settings

Selecting one of the sub menu items allows you to change the global playback settings of The Display 
Window. The settings will always be used when the display window is invoked by MainActor. MainView 
will use them if no command line options are defined. If you need more detailed information of the 
settings, please use the online help of the display window. 

Autostart 
If this item is enabled, the project will directly start to play. Otherwise it will wait for a play command 
from the toolbar or the menu. 

Control Toolbar 
Specifies the position of the control toolbar relative to the display window. 

Titlebar 
Specifies the text to be displayed in the title bar. Either the project title, the current frame number or 
the current frames per second. 

Repeats 
Specifies how many times projects without sound shall be repeated while playing. Projects with sound 
will always only be repeated once. 

Volume 
Specifies the volume of the sound contained in projects. 

The next items are ony available in the Windows version of MainActor and define the full screen mode 
characteristics of DirectX. 

Full Screen 
This item enables the full screen playback mode. 

Scale To Screen 
This item is only available in full screen mode. If this item is enabled, the DirectX system will always 
scale the image to fit the entire size of the screen. 

Use Best Mode 
This item is only available in full screen mode. If this    item is enabled, MainActor tries to find the best 
possible screen mode for the project which is available on your system. Otherwise, full screen 
playback will always use the screen mode of the Windows user interface. 



Toolbar

Selecting one of the sub menu items allows you to control the behaviour of the toolbar. 

Active 
If this switch is on, the toolbar is active. 

Context Help 
If this switch is on, you will get help messages which describe the functions of the buttons of the 
toolbar. Simply deselect this switch to turn the context help off. 



Language

Selecting one of the sub menu items allows you to change the actual language for MainActor. 
The new language will be activated after MainActor has been restarted. 

English 
Switches the actual language to english. 

German 
Switches the actual language to german. 



Custom File Requester

Enables The Custom File Requester for loading of files. 



Mini Icons

Switches between normal icon sizes and mini icon sizes in  The Frame List. 
Mini icons can be useful when you want to see a large number of frames in the frame list. 



Font ...

Opens the font requester. 
Using the requester you can select the font which will be used by MainActor. 



Help Menu



Context Sensitive Help

Activates context sensitive help. Help will be shown    for the next menu / toolbar item or window you 
select. 



About Context Help

MainActor features context senstive help. Simply press F1 for information on the current window or menu 
item. 
You can also activate context help for the next selected menu / toolbar item or window by selecting the 
Context Sensitive Help menu item or toolbar button. 



Help Index

Displays the index of the online help document for MainActor. 



General Help

Displays a general introduction to the user interface of MainActor. 



Using Help

Displays an introduction on how to use the online help facility.      



MainActor Documentation

Shows the documentation of MainActor. 



MainActor Rexx Reference

Displays a document which lists all MainActor commands available to Rexx. 



Rexx Introduction

Displays an introduction to Rexx. 



Rexx Reference

Displays a document featuring a reference of all available Rexx functions. 



Loader Modules...

Opens a dialog window which displays the supplied loader modules of this version of MainActor, as well 
as the supported codecs of these modules. 
The version numbers, copyrights and authors of the modules are displayed as well.      



Saver Modules...

Opens a dialog window which displays the supplied saver modules of this version of MainActor, as well 
as the supported codecs of these modules. 
The version numbers, copyrights and authors of the modules are displayed as well.      



Registration

Shows an informational text on how to register MainActor.      



Serial Number...

Allows you to register your copy of MainActor once you received your personal serial number from us. 



Release Notes

Shows the latest information about this version of MainActor.      



Product Info...

Opens a dialog window which displays the version number of MainActor and the registration status of 
your copy.      



Misc. Menus



Save Animation/Picture/Sound as

These popup menu items cause MainActor to open The Save Window with the selected saver module. 



Misc. Windows



Module Info

This window displays all loader or saver modules which are included in this version of MainActor.    
Each module supports various codecs, the codecs of the currently selected module are listed in the 
Codecs list.    
The author, copyright and version of the currently selected module are listed in the lower left of the 
window, along with the type field which identifies the format of the module, for example Animation or 
Picture.      



Select Range

The Select Range window lets you select a specific range of frames in The Frame List.    
Enter the first frame you want to have selected in the From field and enter the last frame in the to field.    
After that, you can select Accept to select the frames or Cancel to cancel the operation.      



Select Compression

The Select Compression window lets you select the frames in  The Frame List which have a specific 
compression method.    
Select the compression format and select Accept to select the frames with the specified compression 
method or select Cancel to cancel the operation.      



Deselect Range

The Deselect Range window lets you deselect a specific range of frames in The Frame List.    
Enter the first frame you want to have deselected in the From field and enter the last frame in the to field. 
After that, you can select Accept to deselect the frames or Cancel to cancel the operation.      



Deselect Compression

The Deselect Compression window lets you deselect the frames in The Frame List which have a specific
compression method.    
Select the compression method and select Accept to deselect the frames with the specified compression 
method or select Cancel to cancel the operation.      



Project Info

The Project Info dialog window displays some of the more technical information of the current project. 

Name 
The name of the current project. 

Format 
The format of the loader module. 

Width 
The width of the project in pixels. 

Height 
The height of the project in pixels. 

Frames 
The number of frames of the project. 

Loop Frames 
The number of loop frames of the project. 

Average Image Size 
The average size, in bytes, of the image data. 

Average Sound Size 
The average size, in bytes, of the sound data (if any). 

Bits Per Sample 
The amount of bits per sample, typically 8 or 16 bits. The sound quality improves with the number of 
bits. This field is empty when no sound is associated with the project. 

Samples Per Second 
The samples which are played per second. More samples are equivalent with better sound quality. 
This field is empty when no sound is associated with the project. 

Total Project Size 
The total size, in bytes, of the project. 

Color Space Spec 
The color space format of the project. 



Local Timecode

The Local Timecode window allows you to change the local timecodes of the currently selected frames.    
The Local Timecode changes the timecodes of all currently selected frames in The Frame List to the 
new timecode. Note that only a few animation formats support a timecode per frame (for example all IFF-
Anim formats). You can always change the local timecodes for pictures, but they will not be saved. 
The timecode has to be entered in milliseconds. 



The Save Window

The save window is the interface to the save modules which are shipped with the current version of 
MainActor.    
You can select the format in which you want to save the frames in the Modules list. Most modules 
support more than one codec, select the one you want in the Codecs list.    
If you are going to save pictures or an animation, you can select their new width and height in the Width 
and Height entry fields.    
You can now choose if you want to save all the frames of the project, or just those which are selected in 
the The Frame List. If you want to save all frames, enable the All Frames button, otherwise select the 
Selected Frames button.    
The Index entry field is used by the picture saver modules only, it determines the start index of the index 
appended to the pictures. This option is useful if you want to load pictures in a specific order into 
MainActor. To do this simply save the pictures, load them into MainActor and  sort the frames by name. 
You can edit the color palette which will be used for 8bit codecs by selecting the Palette ... button. The 
palette will be created and The Palette Editor will be opened to edit the palette. The editor is nice when 
you want to optimize the palette or want to set a specific color to the 0 index (for example to set it to 
transparent with the GIF saver). Using the editor, you can also load /save palettes. Although you can    
always edit the palette, it will only be used by codecs which use a color palette (8bit codecs). 
The Options ... button will open The Save Options window, which allows some more specific save 
options to be defined. 
You can start the save process by clicking on the Save... button. Choose the name of the new project in 
the file dialog requester. Note that the save modules will append their suffix to the file name automatically,
like ".fli". Also, if you save a series of pictures, the picture index will also be appended, like "0002.bmp". 
You can change the start index with the Index entry field. 
While saving you can stop the action by clicking on Cancel. Cancel will also close the window if no save 
progress is currently running.      



Save Options

The Save Options window contains some more specific options used while saving : 

Interpolate pixels while scaling 
This option is only relevant when new x and y dimension have been entered in the save window. If 
enabled, MainActor uses interpolation when scaling the image to the new size, resulting in less blocky 
looking images. 

Use error diffusion when reducing colors 
When saving 8bit animations/pictures, this option enables an error diffusion algorithm to dither the 
image data. This option is useful when saving deep, 24 bit projects to 8bit, as it reduces the visible 
artifacts of the color reduction. 

Pressing the Module Options ... button will pop up The Module GUI Interface of the currently selected 
saver module (if any). 



Personalisation

Enter your personal serial number into the entry field and select Accept. If you do not yet own a serial 
number (you do not have registered MainActor yet), select Cancel.      



Global Timecode

The Global Timecode window allows you to change the global timecode of your current Project.    
The Global Timecode changes the timecodes of all frames to the new timecode entered in the window. 
This option is important for those animation formats who only support one timecode per animation 
(FLI/FLC). These animation formats often use Dummy frames for timing. 
The timecode has to be entered in milliseconds. 



Repeats Window

Enter the number of times projects without sound shall be repeated while playing. 



Module GUI Interface

This window is the user interface to the modules. 
Description of the options of the various modules is available in The Modules section of the MainActor 
Documentation. 



The Palette Editor

The editor enables you to view and edit the current palette. 
The 256 palette entries are visible at the top of the window, the currently selected palette entry is shown 
right of the Selected Color: text. The red, green and blue values of the current color are displayed in the
labeled entry fields. You can edit these values by entering a new value or by using the spin buttons. 
Swapping colors is possible by entering the color index at the entry field right of the Swap Index: text. If 
you now select the Swap push button, the colors of the current index and the swap index are swapped. 
You can save the palette or load a completely different palette by using the menu items of the File menu, 
making it possible to transfer palettes from/to other programs. 
You can accept the changes by pressing Accept, Cancel will discard the changes to the color palette. 



Video Capture Interface

If you have a video capture card installed on your system, this window allows it to capture video and load 
it directly into MainActor. 
MainActor uses the system interface for capturing video. If you have more than one capture card 
installed, you can choose from the list of available drivers in the Driver menu. 
The Options menu lets you change specific options of the currently selected capture card. The Video 
Format ..., Video Display ... and Video Source ... items open special configuration windows supplied by 
your capture card manufacturer. Please have a look at the online help of these windows for further 
information. 
The Preview item enables the preview mode, the preview mode displays the video the same way as it will
be captured, i.e. it uses the same frame rate etc. 
The Overlay mode (if supported by your card), uses a specific overlay mode to display the video. This 
mode has nothing to do with the quality of the actually captured data. 
The Capture Audio item controls if audio data is captured together with the video data. 
The Record button will start capturing, you can select the name of the capture file first. The Frames Per 
Second button allows you to change the frame rate of the captured data. If you are in Preview mode, you 
can immediately see the changes take effect. 
After capturing, you are asked if you wish to load the captured animation into MainActor. 
Make sure that you choose a compression method for the captured video which is supported by 
MainActor. This can be done by selecting the Video Format ... item. If you want to have support for a 
video format of a specific manufacturer within MainActor, please contact us (and the manufacturer) to 
request support. 



Goto Frame Window

Enter the frame number of the frame which shall be displayed in the The Display Window.      



Speed Window

Enter the frame rate which shall be applied to The Display Window.        



Sound Volume

Please enter the new sound volume. 



The Custom File Requester

This requester offers some enhanced functionality over the system file requester. 
You can select the drives in The Drive List and files and directories in The File And Directory List. 
Pressing the Load button will load the currently selected files, pressing Cancel will close the requester 
without loading a file. 
If the file requester is in single selection mode, the Select and Deselect submenu items of the Files 
menu will be disabled. 
Please use the online menu help for descriptions of the menu functions. 



The Drive List

The drive list contains the drives (disks) which are currently available on your system. 
Selecting a drive will display the current directory of this drive in The File And Directory List. Double 
clicking a drive will display the root directory. 
Note that the Drives menu is available as a popup menu inside of the drive list. 



The File And Directory List

The file and directory list contains the files and directories of the currently selected drive of the The Drive 
List. The directories are located at the top of the list, the files at the bottom. 
You can enter a directory by double clicking on its name. You cannot select directories, only files. Double 
clicking on a file will load it. 
Note that the Files menu is available as a popup menu inside of the file and directory list. 



The Drives Menu

The Drives menu contains the following items: 

Refresh 
This item will refresh The Drive List . 

Exit 
Closes the file requester without loading a file. 



The Files Menu



Select

The submenu items of the Select item select all files or a part of the files in The File And Directory List. 

Select All 
Selects all files. 

Select To 
Selects all files up to the current file. 

Select From 
Select all files starting from the current file. 



Deselect

The submenu items of the Deselect item deselect all files or a part of the files in The File And Directory 
List. 

Deselect All 
Deselects all files. 

Deselect To 
Deselects all files up to the current file. 

Deselect From 
Deselect all files starting from the current file. 



Load Files

The Load Files item will load all currently selected files in The File And Directory List. 



Info Links



The Frame List

The frame list displays all frames of the currently selected  Project. 
Each frame is represented by an icon and several columns of information. 
If the frame is part of an animation, information about the number of the frame, its timecode, compression 
and its size are displayed. Also, if the frame has sound information associated, the frame icon will have a 
small note symbol and the size of the sound data is displayed. If the frame icon of the frame is gray, it 
indicates that the frame is a key frame. 
If the frame (or rather picture) is part of a picture list, its name, timecode, compression method and size is
displayed. 
You can change the way the timecodes are displayed by using the Timecode Settings. 
Every frame has its own popup menu. Double-clicking a frame will display it. 
A preview of the currently selected frame is available in  The Preview Window. 



The Project List

The project list displays all currently loaded projects and occupies the left third of the main window. The 
frames of the currently selected  Project are displayed in The Frame List. 
Double clicking an project will play it, the right menu button will bring up a popup menu which is identical 
to the Project menu. 



The Preview Window

The preview window displays the current frame and its associated audio data (if any). 
The displayed frame is synced with The Frame List, as soon as you select another frame, the preview 
window will display it. 
You can also change the current frame by using the slider    beneath the graphic. The audio displayed is 
exactly the audio data which is associated with this specific frame. 
The right menu button will also bring up a popup menu. 



Project

All projects are displayed as icons in The Project List. 
A project is either an animation / picture or one or more pictures of the same format. All pictures of the 
same format will always be grouped together in one project, this project is named after the picture format. 
The frames of the currently selected project are displayed in The Frame List. 
Each project has its own popup menu, double-clicking on a project will play it back.      



General Help

MainActor is able to load, edit, play and save / convert nearly all animation formats, the most common 
picture formats and sound formats. 
These formats are called projects, each loaded Project is displayed in The Project List. The frames of 
the currently selected project are displayed in The Frame List. 
A preview of the currently selected frame is available in  The Preview Window, the preview window 
offers video and audio preview. 
You can load a new Project with the Open item of the File menu or by dragging the file icon into the 
project list. 
Also, you can change the relative size of the windows by simply changing the location of the sliders which
separate them. 



Release Notes

This is the first official and non-beta release of MainActor. 
We have added lots of features since the last release and now support all major animation formats, all 
animation relevant picture formats and WAV sounds. 
Version v1.1 also adds complete MPEG support. MPEGs can now be generated with audio and lots of 
options. Simply convert your existing animations to MPEG. 
We now hope to have a package which is able to deal with nearly all possible tasks in the animation 
processing / editing area. If you don't agree, tell us about it. 
Of course there is always room to improve, so you will see regular updates in the future. We will 
especially emphasize the editing side in future releases, the long awaited Sequencer add-on with its 
transitions and effects will be the key point in this area. But we also have lots of other stuff coming, like a 
Script language to automate the processing of animations and many other new features are planned. 
New modules should also be integrated in nearly every release. 
This version of MainActor contains several years of development work. If you use MainActor on a regular 
basis, please register. 
We are quite sure to have fixed all reported bugs of the beta versions. If you still encounter any problems,
please contact us. 
 
-- 
Markus Moenig 
markusm@mainconcept.de 
 



Load Error

Either an error has been encountered while loading the project or you did cancel the loading process.    
You can see the cause of the failure in the window, as well as the project at which the failure occurred.      



Error

An error has been encountered. The window displays the error message and the possible cause for the 
error.      



MainView

MainView is the external player of MainActor. It should be used if you just want to play an animation or 
to view a picture.    
During the loading process, the name of the project, its format and the width and height are displayed. 
The progress indicator displays how much of the project has already been examined. If the project has 
been loaded the frames field is updated with the number of frames of the project.    
MainView will display warning messages of the loader modules in red at the bottom line of the window.    
After loading, the project will be shown.    



Registration

If you decide to register MainActor, we will send you a personal serial number which will be able to 
unlock all future versions of this software on all available platforms. 
MainActor is currently running on OS/2 and Windows 95 / NT 4.0. 
The fee for MainActor is $60 (99,- DM) or any equivalent sum in your local currency. Please no foreign 
checks (except EuroChecks). We do take Master/EuroCard and VISA.    
You can contact us at : 
 
MainConcept, GbR Moenig/Zabel 
Hermann-Heusch-Platz 3 
D-52062 Aachen 
Germany 
 
Tel:   +49-(0)241-4090444 
FAX:   +49-(0)241-4090445 
BBS:   +49-(0)241-4090446 
 
Email: info@mainconcept.de  
http://www.mainconcept.de 
 
You can also order at BMT Micro. Please have a look at the file bmtmicro.txt included in this package. 
Online registration for the Windows version is also available at http://www.buydirect.com. 



Select all

Selects all frames in The Frame List. 



Deselect all

Deselects all frames in The Frame List. 



Rexx I/O

The Rexx I/O window displays the output of the Rexx scripts started by MainActor. 
You can save the text, or copy it to the clipboard etc. 
You can also stop the currently running Rexx script by selecting the Stop Rexx menu item. 



Context Sensitive Help

Activates context sensitive help. Help will be shown    for the next menu / toolbar item or window you 
select.    






